ownCloud User Manual

The ownCloud Team

Version: 10.9, March 05, 2022



Table of Contents

INErOAUCTION. 1
WeEDUI OVeIVIEW . o 2
INErOAUCTION oo 2
File CONtrOlS oo 2
The Web Interface . ... 5
Personal SEttiNGS . . . 6
Navigating the WebUl . ... .o 17
GO NS o 20
CUSEOM GIOUPS .« o oot e e e e e e 27
FIlES o 24
Public Link Shares . ... oo 56
Using Federation Shares . ... ... 59
SeSSION MaNageMENT . . oo 61
Version CONTrOl ..o 62
Online Collaboration. . ... 63
Storage QUOTAS . .. o 64
Configuring EXternal Storage. . ... ... 65
Connecting to SharePoint (Enterprise only) . ... 65
Desktop and Mobile Synchronization ....... ... . . 66
RS o e 68
THE ACTIVITY ADD .« 68
Using the Calendar APp . .. oo o oo 70
Using the CONTatIS APP . o oo oo oot 70
THE Markel ADD © e 70
The Media VIEWET ADD . oo 71
LT ={r= 0] o P 73
Integrate ownCloud into Microsoft Teams . ... 73
Contacts & Calendar . . ... 74
iOS - Synchronize iIPhone/iPad . ... 74
Synchronizing with KDE SC ..o 75
SYNChronizing With OS X. ..o 77
Thunderbird - Synchronize Addressbook . ............ . 78
TroUDIESNOOTING . . . o 80
Error while copying file to target location (copied bytes: xxx, expected filesize:yyy) ........... 80
Sharing sidebar does not show Shared with you by ... forremoteshares ................. 80
PIM Troubleshooting. . ... ..o oo 80

Have You Found a Mistake In The Documentation? .. ... 81



Introduction

Welcome to ownCloud: your self-hosted file sync and share solution.

ownCloud is an open source file sync and share software for everyone from individuals
operating the free ownCloud Server edition, to large enterprises and service providers
operating the ownCloud Enterprise Subscription. ownCloud provides a safe, secure,
and compliant file synchronization and sharing solution on servers that you control.

You can share one or more files and folders on your computer, and synchronize them
with your ownCloud server. Place files in your local shared directories, and those files
are immediately synchronized to the server and to other devices using the ownCloud
Desktop Sync Client, Android app, or iOS app. To learn more about the ownCloud
desktop and mobile clients, please refer to their respective manuals:

* ownCloud Desktop Client
* ownCloud Android App
* ownCloud iOS App
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WebUI Overview

Introduction

You can access your files with the ownCloud Web interface, as well as: create, preview,
edit, delete, share, and re-share files.

o Your ownCloud administrator has the option to disable these features. If
any of them are missing on your system ask your server administrator.

00 e < in] ® N 0O O localhost:B080index.php/appsifiles/Zdir=(&filsid=2 2 LY ER=D

| Allfiles L +
W Favorites Name Size Modified
Shar ith
< aredwith you ownCloud Manual Shared 43MB
=, Shared with others
. test 16 days ago
& Shared by link
Photos Shared
Tags
Documents Shared

(# External storage

Deleted files

G Settings

File Controls

When you mouseover, or hover over, a file in the Files view, as in the image below,
ownCloud displays three file controls. These are:

1. Marking Favorites
2. Sharing Files
3. The Overflow Menu

Marking a Favorite Sharing Options
The Overflow Menu

| Documents -+

Name Size Modified

% Example.odt ( a month ago
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Marking Favorites

Click the star to the left of the file icon to mark it as a favorite. You can quickly find all

of your favorites with the Favorites filter on the left sidebar.

i Documents e

By default, a file will not be B senpe
a favorite.

= Documents +

First, hover over the file's ¥y E Example.odt
row to see the favorite star,

Documents +

Then click the star to mark E Eample.ock
the file as a favorite.

\ 4

Sharing Files

The sharing files control is a shortcut to the file and folder sharing functionality within

ownCloud. ownCloud sharing supports:

» Sharing files and folders with users or groups
* Creating public link shares with hyperlinks
» Listing recipients of existing shares

* Deleting existing shares
The Overflow Menu

The Overflow Menu allows you to:

* Display File Details
* Rename Files

* Download Files

* Delete Files
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Display File Details

When you display details about a file, by clicking [ Det ai | s] in the Overflow Menu, a
set of tabs (or views) are available. These are:

View Description

Details This shows details about a file, such as its name, size, and when it was
created or last updated. To know more, refer to the Details section.

Activity This shows a history of activity on the file, such as when it was
created, updated, and shared. To know more, refer to the Activity
section.

Sharing It’s here that shares are managed. To know more, refer to the Sharing

Files section.

Version This shows a history of all the versions of the file. This is not available
for folders. To know more, refer to the Version Control section.

You can see an example of the Activity view in the image below.

A

project] « Shared

beach_stump

crabpots crabpots.jpg

90 kB, 13 minutes ago

iPE &

4"1

crooked_river_bend Activities Sharing Versions

-+ You created crabpots.jpg

host_trees :
& - 13 minutes ago

A=

Y

grebe
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Rename Files

To rename a file, click Rename in the Overflow Menu. The file’s current name will be
displayed in an editable text box. Change the name, click Ent er, and the file will be
renamed. If you don’t want to rename it, click esc and the file name will be left as is.

Download Files

To download a file, click Download in the Overflow Menu.

Delete Files

To delete a file, click Delete in the Overflow Menu.

The Web Interface

You can connect to your ownCloud server using any Web browser; just point it to your
ownCloud server and enter your username and password. Supported Web browsers
are:

* Edge (current version on Windows 10)

* TE11 or newer (except Compatibility Mode)

* Firefox 60 ESR or newer

¢ Chrome 66 or newer

Safari 10 or newer

0 Some apps like files_external or encryption will disable the Stay logged
in checkbox.

Navigating the Main User Interface

By default, the ownCloud Web interface opens to your Files page. You can add,
remove, and share files, and make changes based on the access privileges set by you
(if you are administering the server) or by your server administrator.

The ownCloud user interface contains the following fields and functions:

* Apps Selection Menu: Located in the upper left corner, click the arrow to open a
dropdown menu to navigate to your various available apps.

* Apps Information Field: Located in the left sidebar, this provides filters and tasks
associated with your selected app. For example, when you are using the Files apps
you have a special set of filters for quickly finding your files, such as files that have
been shared with you, and files that you have shared with others. You'll see
different items for other apps.

* Application View: The main central field in the ownCloud user interface. This field
displays the contents or user features of your selected app.

* Navigation Bar: Located over the main viewing window (the Application View),
this bar provides a type of breadcrumbs navigation that enables you to migrate to
higher levels of the folder hierarchy up to the root level (home).
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* New Button: Located in the Navigation Bar, the [ New] button enables you to
create new files, new folders, or upload files.

You can also drag and drop files from your file manager into the

o ownCloud Files Application View to upload them to ownCloud.
Currently, the only Web browsers that support drag-and-drop folders
are Chrome and Chromium.

* Search Field: Click on the [ nagni fi er] in the upper right-hand corner of to
search for files.

* Personal Settings Menu: Click on your ownCloud [ user nane], located to the
right of the Search field, to open your Personal Settings dropdown menu. Your
Personal page provides the following settings and features:

o Links to download desktop and mobile apps
o Re-run the First Run Wizard

o Server usage and space availability

o Password management

o Name, email, and profile picture settings
o Manage connected browsers and devices
o Group memberships

o Interface language settings

o Manage notifications

o Federated Cloud ID

o Social media sharing buttons

o SSL certificate manager

o ownCloud Version information

See userpreferences section to learn more about these settings.

Personal Settings

As a user, you can manage your personal settings. To access them:

Click on your username in the top, right-hand corner of the WebUI of your ownCloud
instance.

The Personal Settings Menu opens.

Q (:,-

& Personal

When clicked, the Personal list on the top left on the screen appears:
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G

In

Personal

L General

Storage
=<, Sharing
U Security

=+ Additiona

(r') The options listed in the Personal Settings page depend on the
- applications that are enabled by the administrator.

eneral Settings

troduction

In general settings, some of the features you will see include the following:

Usage and available quota
Manage your profile picture

Full name
You can make this anything you want, as it is separate from your ownCloud login
name, which is unique and cannot be changed

Email address

List your group memberships

Manage your password

Choose the language for your ownCloud interface
Links to desktop and mobile apps

Manage your activity stream and notifications
Default folder to save new documents to

Your federated sharing ID

Social sharing links

ownCloud version

The following image is a example screen of the General section:
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[ ] ® < (Em] @ owncloud.localdomain/index.php/settings/personal?sectior (1) @ ® t (] T

X ownCloud admin -
Personal
You are using 163 B
1 General
Storage Profile picture Full name
=< Sharing admin
U Security Email
=== Additional Set email

* = Groups
You are member of the following groups:
admin
Password
Change password
Language
English ¥  Help translate

Federated Cloud

Your Federated Cloud ID: admin@owncloud.localdomain

Share it:

B GNU Social * Diaspora ,Twit:er f Facebook S+Google+ Add to your website

Get the apps to sync your files

ANDROID APP ON # Download on the

ORISR | P> Google Play | @ App Store

If you want to support the project join development or spread the word!

Version

ownCloud 10.3.0 alpha2 (git)
Developed by the ownCloud community, the source code is licensed under the AGPL.

Managing Your Profile Picture

8 | Personal Settings



Profile picture

Profile picture

Upload a Remove profile
profile picture picture

I+
v
L[

Select a profile
picture

Changing Your Profile Picture
There are two options to set your profile picture:

* You can upload an image; or

* Select an existing profile picture

Upload a Profile Picture

To upload an image click the "Upload new" £ button, which opens a file browser,
through which you can choose an image to upload. After you’'ve chosen an image, you
will then be able to crop the uploaded image, if required, to just the segment of the
image that you want to use for your profile picture. You can see an example in the
screenshot below.
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Profile picture Full name

-
@),

Products Private Cloud

Store. Share. Work.

OWNCLOUD TOUR

Choose as profile picture
+hange password

Figure 1. Crop the new profile picture

When you’re happy with the image, click [ Choose as profile picture], and the
image will be set as your profile picture.

@ the image can be a maximum of 20MB in size.

Select a Profile Picture
To select a profile picture, click the Select from Files ™ button and the profile

picture chooser will open. From there, pick the profile picture that you want and click
[ Choose] .
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’rofile picture Full name

-

Select a profile picture

Set email

I+
[

2assworg

i

anguage

English

Choose

-ederatel

‘our Federated Cloud |D: admin@owncloud.localdomain

Figure 2. Choose a new profile picture

Remove Your Profile Picture

To remove a custom profile picture, click the Remove Profile ¥ button. After that,
the image will revert to the default image, present when you first logged in.

Update Your Full Name

To update (or change) your full name, amend the existing text in the text box below
“Full name”. After a few seconds, your full name will be auto-saved.

Full name

John Your full name has been changed.

Figure 3. Successfully updated full name

If the full name cannot be changed, you will see a notification, as in the example
below.
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Full name

Matthevd Unable to change full name

Figure 4. Problem updating full name

Update Your Email Address

To update your email address, change the address in the text box below “Email” and
click [ Set email].

Update Your Password

Password
Change password

Figure 5. Update current password.

To change your password, under Password, enter your current password in the first
password field (with the placeholder text “Current password”) and your new password
in the second password field (with the placeholder text “New password”), and then
click [ Change password].

o Password changes automatically log out all connected
browsers/devices.

Set the Language

Language
English * Help translate

Figure 6. Change profile’s language

To change the language for your user account, pick the desired language from the
dropdown under Language. The new language will be auto-saved shortly after you
select it.

External Storage

Introduction

If your ownCloud administrator has enabled External Storage for users, you will be
able to add one or multiple external storages depending on the allowed storage types.

Personal

External Storage

1 General Folder name External storage Authentication Configuration
Add storage A

I Storage

=, Sharing

Figure 7. User Storage Settings
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Configuration

To configure one or more external storages, please refer to the External Storage
documentation.

Sharing
Introduction
This section allows you to set whether or not you want to:

* Automatically accept new incoming local user shares

* Allow finding you via autocomplete in share dialog.

Settings

To enable either, check the respective checkbox. This section also allows for
configuring Federated Cloud Sharing.

Personal

Sharing
1 General % Automatically accept new incoming local user shares
¥ Allow finding you via autocomplete in share dialog. If this is disabled the full username needs to be entered.
Storage
Federated Cloud Sharing
=, Sharing
Nothing to configure.
U Security

Figure 8. User Sharing Settings

Security

Introduction
The security settings page allows for:

* Managing Two-Factor Authentication (if enabled by the administrator)
* Managing CORS white-listed domains
* Viewing and deleting user sessions

* Creating new app passcodes
Settings

Two-Factor Authentication

Two-Factor Authentication appears only if enabled by the administrator. It is never
enabled by default and as a user you can opt-in and also stop this kind of additional
security measure. When enabled and set up, you have to enter, in addition to your
password, a second factor which is a time-based one-time password (TOTP) provided
via another device during the web login. This device can be a mobile phone or another
device providing the second factor, e.g. via an app or SMS.

In the setup example below, an app on the mobile phone will be used to provide the
second factor. For your convenience, some example apps are listed:

iOS App Store

Microsoft Authenticator
2FA Authenticator (2FAS)
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Google Play Store

Microsoft Authenticator
Google Authenticator
2FA Authenticator (2FAS)

afh -~
‘C‘.., ownCloud

Personal TOTP Second-factor Auth
2 Ceners Activate TOTP

Storage CORS
< oo Cross-Origin Resource Sharing

White-listed Domains

No Domains.

Figure 9. Enable Two-Factor Authentication

After enabling Two-Factor Authentication via the [ Acti vat e TOPT] check mark, the
image changes and you can proceed with finalizing the setup.

l’\ ~
‘t‘.’, ownCloud

Personal TOTP Second-factor Auth
Activate TOTP

his is your new TOTP secret: BCWZHKSTQZPUMNJX

o enable second-factor verify authentication code below

Authentication code Verify

Figure 10. Activated Two-Factor Authentication

To finalize the setup, follow the app’s directions to scan the QR code. The number
displayed (2nd factor) needs to be entered in the browser dialog in the
[ Aut henti cati on code] field.

Log out and after your next regular login with user name and password, you will be
asked to enter the number that the app provides. The number changes after some time
and usually a counter is shown how much time is remaining after the next number
appears.
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Disable Two-Factor Authentication

You can disable the two-factor authentication at any time by unchecking [ Acti vat e
TOPT]

Lost or Defect Device

If the device providing the second factor gets lost or is defect, the administrator can
temporarily disable the two-factor authentication for the account in question. A login
can then be made without providing the second factor. If the issue is solved, the
administrator can re-enable two-factor authentication.

CORS White-listed Domains
CORS
Cross-Origin Resource Sharing
White-listed Domains
Mo Domains.

Add Domain

Add

Figure 11. CORS (Cross-origin Resource Sharing) configuration section

The CORS (Cross-origin resource sharing) white-listed domains section lists zero or
more domains which the ownCloud instance is allowed to request resources from, in
addition to the current domain, for your user account.

By default, as in the screenshot above, no domains will be listed. If you want to add
one, or more, add them, one at a time, in the Domain text field, and click [ Add] . You
will then see them listed, as in the screenshot below.

Valid records:
Record Scheme Example
protocol + domain  https://example.com

protocol + domain  https://example.com:80

o + port

protocol + ip http://127.0.0.1
protocol + ip + port http://127.0.0.1:8080

CORS entries follow strict rules, only http and https protocols are
allowed.

To remove one, or more, click the trashbin icon next to the relevant domain name.
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CORS

Cross-Origin Resource Sharing

White-listed Domains

http://localhost

Add Domain
Add

Figure 12. CORS Configuration Section with white-listed domains

You will then be prompted to confirm if you want to remove the domain. If you do,
click [ Yes] . If you do not, click [ No] .

Sessions

Sessions

These are the web, desktop and maobile clients currently logged in to your ownCloud.

Browser Most recent activity
Mozilla/5.0 (Macintosh; Intel Mac OS X 10_14_&) AppleWebKit/6... seconds ago

Meozilla/5.0 (Macintosh; Intel Mac OS5 X 10_14_6) AppleWebKit/&... 5 hours ago

[}
Mozilla/S.0 (X11; Ubuntu; Linux x86_64; rv:69.0) Gecko/201001.. 12 days ago [ ]
Mozilla/5.0 (Macintosh; Intel Mac OS X 10.14; rv:69.0) Gecko/20... 14 days ago [ ]

Figure 13. Sessions section

The sessions section, which you can see an example of below, lists all your current
user sessions, across web, desktop, and mobile clients. Specifically, it lists the browser
user agent string and the time of the most recent activity. If you want to log a session
out, then click the Disconnect button at the far right of the relevant session.

App Passwords / Tokens

App passwords / tokens

App passwords or tokens are passcodes that give an app or device permissions to access your ownCloud account.
Use them as a security measure to hide your actual password which you may only want to use for web interface login.

Create new app passcode
Figure 14. App password / tokens section

This section lets you give an app or device permissions to access your ownCloud
account. App passwords are a security measure which let you hide your actual
password. To create one, insert the app name in the text field and click [ Creat e new
app passcode].
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App passwords / tokens

You've linked these apps.

Name Maost recent activity

Dummy app seconds ago

App passwords or tokens are passcodes that give an app or device permissions to access your ownCloud account.
Use them as a security measure to hide your actual password which you may only want to use for web interface login.
Use the credentials below to configure your app or device.

Username admin
Password / Token | PUIDL-GGWFI-VXIRP-AMLDO Done
Figure 15. Create new app password / token

As you can see in the screenshot above, a username and password/token will be
generated, and the app will be listed in the apps list in this section.

Make sure you either securely store the username and password /
o token or ensure that the receiver does, because once you click [ Done]
the username and password / token will longer be discoverable.

If you want to revoke access for a device or app, click the trash bin icon next to its
name in the apps list.

o No confirmation of revocation is requested. Once you click the trash bin
icon, the apps access is revoked.

Navigating the WebUI

Introduction

Navigating through folders in ownCloud is as simple as clicking on a folder to open it
and using the back button on your browser to move to a previous level. This section
walks you through how to navigate the ownCloud UI.

Create and Upload Files and Directories

At the top of the Files view is a navigation bar. This contains links to uploading and
creating new files and folders.

# +

Text file

Folder
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To upload or create new files or folders directly in an ownCloud folder, click on the
[ New] button in the navigation bar (this is the + button). There, as in the image above,
you can see links to:

* [Upl oad a new file] This uploads files from your computer into ownCloud. You
can also upload files by dragging and dropping them from your file manager.

* [Create a new text file] This creates a new text file and adds the file to your
current folder.

e [Create a new fol der] This creates a new folder in the current folder.

Select Files or Folders

Narme Size Modified

ownCloud Manual Shared 4.3 MB

tl test 16 days ago
Photos Shared

Documents Shared

You can select one or more files or folders by hovering over them (as in the image
below) and clicking on their checkboxes. To select all files in the current directory,
click on the checkbox located at the top of the files listing.

% 3folders and 1 file 4 Download 5 MB Delete
& ownCloud Manual Shared 4.3 MB
m test 16 days ago
m Photos Shared
m Documents Shared

When you select multiple files, you can delete all of them, or download them as a ZIP
file by using the [ Del et e] or [ Downl oad] buttons that appear at the top.

o If the [ Downl oad] button is not visible, the administrator has disabled
this feature.

Filter the Files View

The left sidebar on the Files page contains several filters for quickly sorting and
managing your files.
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Option Description

All files The default view; displays all files that you have access to
Favorites Files or folders marked with the yellow star

Shared with you Displays all files shared with you by another user or group

Shared with Displays all files that you have shared with other users or groups
others

Shared by link Displays all files that are shared by you via public link

External Storage Files that you have access to on external storage devices and
services such as Dropbox, Google, and Amazon S3

Move Files

You can move files and folders by dragging and dropping them into any directory.

Play Videos

You can play videos in ownCloud with the Media Viewer app by clicking once on the
file. Please note, video streaming by the ownCloud Media Viewer depends on your web
browser and the video’s format.

If your ownCloud administrator has enabled video streaming, but it

o doesn’t work in your Web browser, it may be a browser-related issue.
See Mozilla’s Browser Compatibility Guide for supported multimedia
formats in Web browsers.

Settings

The Settings gear icon in the lower left-hand corner of the ownCloud window allows
you to show or hide hidden files in your ownCloud Web interface. These are also called
dotfiles, because they are prefixed with a dot, e.g. .mailfile.

The dot tells your operating system to hide these files in your file browsers, unless you
choose to display them. Usually, these are configuration files, so having the option to
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hide them reduces clutter.

'I:} Settings

Show hidden files

Preview Files

ownCloud can display thumbnail previews for images, MP3 covers, and text files, if
this is enabled by your ownCloud administrator. You can also display uncompressed
text, OpenDocument, videos, and image files in the ownCloud embedded viewers by
clicking on the file name. There may be other file types you can preview if your
ownCloud administrator has enabled them. If ownCloud cannot display a file, it will
start a download process and downloads the file to your computer.

Comments

Introduction

In ownCloud, you can add one or more comments on both files and folders. This
section describes how to add, edit, and delete comments.

You can navigate directly to the comments pane for a file by using the
G URL:
Q https://your.owncloud.domain/f/?<$fileld>?details=commentsTabView,
and substituting <$fileld> for the file’s id.

Add Comments

Use the Details view, in The Overflow Menu, to add and read comments on any file or
folder. Comments are visible to everyone who has access to the file or folder. To add a
comment, as in the example below, click the [ Corment s] tab in the Details view, write
a comment in the New Comment field, and click [ Post ] .
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files/webgui/overview.pdf#the-overflow-menu

x
project-docs
4 hours ago peRERE
a day ago Activities Comments Shar
an hour ago a molly smith
watching the years go b
a day ago g goo)
44 minutes ag Post
20 hours ago
Q melly smith 20 hours ago
2 hours ago My god, what have | done
18 hours ago R terry terrier 20 hours ago
This Is not my beautiful wife,
20 hours ago
'.h" freda mae 20 hours ago
20 hours ago This Is not my beautiful house.
19 hours ago Q molly smith 20 hours ago

Edit Comments

To edit an existing comment on a file or folder, hover the mouse over the comment and
you will see a pencil icon appear. By clicking on the pencil, the [ Edit Conment] field
will appear, pre-filled with the comment text. Change the text as necessary and click

[ Save] . If you change your mind, just click [ Cancel ] .

Delete Comments

To delete an existing comment on a file or folder, as with editing comments, hover the
mouse over the comment and you will see a pencil icon appear. Click the pencil, and a
rubbish bin icon appears on the far right-hand side of the comment author’s name,
above the [ Edit Comment] text field. Click the [ r ubbi sh bi n], and the comment will
be deleted after a few seconds.

Custom Groups

Introduction

In previous versions of ownCloud, if you wanted to share a file or a folder with more
than one person, you had to share it either with many people individually, or share to
one or more groups. However, you could only share with groups which your ownCloud
administrator had already created.

This wasn’t the most efficient way to work. To address that, as of ownCloud 10.0, you

Custom Groups | 21



can now create your own groups on-the-fly, through a feature called "Custom Groups".
Here’s how to use it.

Creating Custom Groups

Assuming that your ownCloud administrator’s already enabled custom groups; under
the admin menu, in the top right-hand corner, click [ Setti ngs] (1). Then, in the main
menu on the settings page, in "Personal" section, click the option: [ Cust ongr oups]
(2). This will take you to the "Custom Groups" admin page.

L ® < [ @® Wt} @ D & localhost/index

Personal

Custom GV-C)LJ[JS ean Leave this group x

—
1 e Create group

To create a new custom group, in the text field at the top where you see the
placeholder text: "Group name", add the group name and click [ Creat e group].
After a moment or two, you’ll see the new custom group appear in the groups list.

Please be aware of two things:

1. Custom groups are visible only to members of the group, but not to
o anyone outside the group; and

2. ownCloud administrators can see and modify all custom groups of an
instance.

Managing Group Members

[ ) ® < [Em] @ hY @ ® localhost/index.php/settings/personal?sectionid=customg ¢ (4] i [ul +

User "share2" is already a member of this group @

r
¢@b, scttings -

Personal

Custom Groups the team = x
2 General Create group
Storage Srou Your role flembe
8 Security the team Member & admin Group admin
e Additional
sharel Member

£+ Customgroups

e share2 Member

Admin

General

To add or remove users in a custom group, click your role (1), which will likely be
"Member" (at least at first), and you’ll see a panel appear on the right-hand side
listing the group’s users and their roles. In the "Add user to this group field" at the
top of the panel (2), start typing the name of the user that you want to add.
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After a moment or two, you’'ll see a list of users that match what you’ve typed appear
(if there are any) in a popup list. Click the one that you want, and they’ll be added to
the group. Finally, you'll see a confirmation at the top of the page (3), indicating that
the user’s been added to the custom group.

manage a group’s members, change a group’s name, change members’

o Members can only use a group for sharing, whereas group admins can
roles, and delete groups.

Sharing with the Group
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¢ Shared with others c
6 days ago Activities Comments Sharing
& Shared by link
ol 43MB 6 days ago User and Groups  Public Links

Tags

team l

/ T ) team (group)

To share a file or folder with your custom group, open the sharing panel (1). Then, in
the "User and Groups' field (2), type part of the name of the custom group and wait a
moment or two.

The name of the group should be displayed in a popup list, which you can see in the
screenshot above. Click on it, and the file or folder will then be shared with your
custom group with all permissions initially set.

Changing Group Names

If you want to change the name of the custom group, mouseover the group’s name in
the custom groups list, where you will see a pencil appear to the right of the existing
name. Click it, and a text field will appear, pre-populated with the existing name.
Change the name and click enter, and the name will be changed.

[ ) ® < Em] G heY (D ©) localhost/index.php/settings/personal?sectionid=customgrc & (4] \'I'I [ul
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Custom Groups
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Storage
Rename

8 Security
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e Additional \

Customgroups .
o group mouseover, click, and rename

Admin
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Files

This section covers how to work with and user files when using ownCloud.

Accessing ownCloud Files Using WebDAV

Introduction

ownCloud fully supports the WebDAV protocol, and you can connect and synchronize
with your ownCloud files over WebDAV. In this chapter you will learn how to connect
Linux, Mac OS X, Windows, and mobile devices to your ownCloud server via WebDAV.
Before we get into configuring WebDAYV, let’s take a quick look at the recommended
way of connecting client devices to your ownCloud servers.

ownCloud Desktop and Mobile Clients

The recommended method for keeping your desktop PC synchronized with your
ownCloud server is by using the ownCloud Desktop Client. You can configure the
ownCloud client to save files in any local directory you want, and you choose which
directories on the ownCloud server to sync with. The client displays the current
connection status and logs all activity, so you always know which remote files have
been downloaded to your PC, and you can verify that files created and updated on your
local PC are properly synchronized with the server.

The recommended method for syncing your ownCloud server with Android and Apple
iOS devices is by using the ownCloud Mobile apps.

To connect to your ownCloud server with the ownCloud mobile apps, use the base
URL and folder only:

example.com/owncloud

In addition to the mobile apps provided by ownCloud, you can use other apps to
connect to ownCloud from your mobile device using WebDAV. WebDAV Navigator is a
good (proprietary) app for Android devices and iPhones. The URL to use on these is:

example.com/owncloud/remote.php/webdav

WebDAV Configuration

If you prefer, you may also connect your desktop PC to your ownCloud server by using
the WebDAV protocol rather than using a special client application. Web Distributed
Authoring and Versioning (WebDAV) is a Hypertext Transfer Protocol (HTTP) extension
that makes it easy to create, read, and edit files on Web servers. With WebDAV you can
access your ownCloud shares on Linux, Mac OS X and Windows in the same way as
any remote network share, and stay synchronized.

6 In the following examples, You must adjust example.com/ to the URL
of your ownCloud server installation.

Accessing Files Using Linux

You can access files in Linux operating systems using the following methods.
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Nautilus File Manager

Use the davs:// protocol to connect the Nautilus file manager to your ownCloud share:

davs://example.com/owncloud/remote.php/webdav

o If your server connection is not HTTPS-secured, use dav:// instead of
davs://.

. Files FriFeb 8,1814
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dav://localhost/files/webdav.php
{@ Trash
Cavicas About Files

Help Recent Servers

Computer
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Accessing Files with KDE and Dolphin File Manager

To access your ownCloud files using the Dolphin file manager in KDE, use the
webdav:// protocol:

webdav://example.com/owncloud/remote.php/webdav

Files | 25



webdav - localhost - webdav — Dolphin

Tools  Sektkings  Help

s | @ Find | | Preview | 4 split | G Delete

= ﬁfebdﬂ\r:,l",l"localhust,.l"owncloud,l"remote.phpj"webdaw"

ﬁame : Size ‘Date
» i documents Unknown 12/26/141
¥ i music Unknown 12/26/14 1
» i phoktos Unknown 12/26/141
k ownCloudUsertanual.pdf 1.7 MIB 12/26/14 1

You can create a permanent link to your ownCloud server:

1. Open Dolphin and click [ Net wor k] in the left-hand column.

F

Network — Dolphin - o x

{ > aB == &8 Q Find [Preview [split = Control +

Places Network
s Home Name * Modified
@Root M N e,
3 iBluetooth
WTrash | W

R 1. 4 & MTP Devices
Recently Saved 4 @ Network

Today

Yesterday 4 @ Shared Folders (SMB)

This Month /’“‘““-'m*—---—\]z.
Add Network Folder

Last Month l\i ¢ ' |

2. Click on the icon labeled [ Add a Networ k Fol der].
The resulting dialog should appear with WebDAV already selected.

3. If WebDAV is not selected, select it.
4. Click [ Next] .
5. Enter the following settings:

o Name: The name you want to see in the Places bookmark, for example
ownCloud.

o User: The ownCloud username you used to log in, for example admin.
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o Server: The ownCloud domain name, for example example.com (without
https:// or http://).

o Folder: Enter the path owncloud/remote.php/webdav.

r

Network Folder Wizard — KDE Network Wizard X

Network Folder Information

Enter a name for this WebFolder as well as a server address, port and folder path to use and
press the Save & Connect button.

Name:
User:
Server:
Port: 80

Folder:

(w4 Create an icon for this remote folder

[ | Use encryption

Help < Back Save & Connect Cancel

6. (Optional) Check the [ cr eat e] icon checkbox for a bookmark to appear in the
Places column.

7. (Optional) Provide any special settings or an SSL certificate in the [ Port &
Encrypt ed] checkbox.

Creating WebDAV Mounts on the Linux Command Line

You can create WebDAV mounts from the Linux command line. This is useful if you
prefer to access ownCloud the same way as any other remote filesystem mount. The
following example shows how to create a personal mount and have it mounted
automatically every time you log in to your Linux computer.

1. Install the davfs2 WebDAV filesystem driver, which allows you to mount WebDAV
shares just like any other remote filesystem. Use this command to install it on
Debian/Ubuntu:

sudo apt-get install davfs2
2. Use this command to install it on CentOS, Fedora, and openSUSE:
sudo yum install davfs2
3. Add yourself to the davfs2 group (this will be effective after the next login):

sudo usermod -aG davfs2 <username>

Files | 27



4. Then create an owncloud directory in your home directory for the mountpoint, and
.davfs2/ for your personal configuration file:

mkdir ~/owncloud
mkdir ~/.davfs2

5. Copy /etc/davfs2/secrets to ~/.davfs2:

sudo cat /etc/davfs2/secrets > ~/.davfs2/secrets

6. Make the permissions read-write owner only:

chmod 600 ~/.davfs2/secrets

7. Add your ownCloud login credentials to the end of the secrets file, using your
ownCloud server URL and your ownCloud username and password:

/home/<username>/owncloud <username> <password>

8. Add the mount information to /etc/fstab:

https://example.com/owncloud/remote.php/webdav
/home/<username>/owncloud davfs user,rw,auto 0 O

9. Then test that it mounts and authenticates by running the following command. If
you set it up correctly you won’t need root permissions:

mount ~/owncloud

10. You should also be able to unmount it:

umount ~/owncloud

Now every time you login to your Linux system your ownCloud share should
automatically mount via WebDAV in your ~/owncloud directory. If you prefer to mount
it manually, change auto to noauto in /etc/fstab.

Known Issues
Problem: Resource Temporarily Unavailable

Solution

If you experience trouble when you create a file in the directory, edit
/etc/davfs2/davfs2.conf and add:
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use_locks 0

Problem: Certificate Warnings

Solution

If you use a self-signed certificate, you will get a warning. To change this, you need to
configure davfs2 to recognize your certificate. Copy mycertificate.pem to
/etc/davfs2/certs/. Then edit /etc/davfs2/davfs2.conf and uncomment the line
servercert. Now add the path of your certificate as in this example:

servercert /etc/davfs2/certs/mycertificate.pem

Accessing Files Using Mac OS X

The Mac OS X Finder suffers from a series of implementation problems

o and should only be used if the ownCloud server runs on Apache and
mod_php. You can use a tool like ocsmount to mount without those
issues.

To access files through the Mac OS X Finder:

1. Choose Go > Connect to Server.

The "Connect to Server" window opens.
2. Specify the address of the server in the Server Address field.
® Finder File Edit View Je.l Window Help
' Back #[
Forward = ]
Enclosing Folder

2l All My Files
7 Documents +380
EX Desktop ¢#D

3 Downloads L
% Home {+3H
= Computer 4 38C
@ AirDrop {+3R
™ Network {+ 3K

% Applications %A
S Utilities

Recent Folders

Co to Folder...
Connect to Server... 3K

For example, the URL used to connect to the ownCloud server from the Mac OS X
Finder is:
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http://sabre.io/dav/clients/finder/
https://apps.apple.com/de/app/ocsmount/id1411490371

https://example.com/owncloud/remote.php/webdav

Connect to Server

Server Address:

http: [ /your ownCloud.com

Favarite Servers:

Remove Browse Connect

3. Click [ Connect].
The device connects to the server.

For added details about how to connect to an external server using Mac OS X,
check the wikihow documentation

Accessing Files Using Microsoft Windows
It is best to use a suitable WebDAV client from the WebDAV Project page .

If you must use the native Windows implementation, you can map ownCloud to a new
drive. Mapping to a drive enables you to browse files stored on an ownCloud server
the way you would files stored in a mapped network drive.

Using this feature requires network connectivity. If you want to store your files offline,
use the ownCloud Desktop Client to sync all files on your ownCloud to one or more
directories of your local hard drive.

Prior to mapping your drive, you must permit the use of Basic
Authentication in the Windows Registry. The procedure is documented

e in Windows 7 cannot automatically reconnect a DAV share when Basic
Authentication is used and Office applications open blank from
SharePoint WebDAV or sites. Please follow the Knowledge Base article
before proceeding.

Mapping Drives With the Command Line

The following example shows how to map a drive using the command line. To map the
drive:

1. Open a command prompt in Windows.

2. Enter the following line in the command prompt to map to the computer Z drive,
where <drive path> is the URL to your ownCloud server:
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net use Z: https://<drive_path>/remote.php/webdav /user:youruser
yourpassword
Example:

net use Z: https://example.com/owncloud/remote.php/webdav /user:youruser
yourpassword

"" The computer maps the files of your ownCloud account to the drive letter Z. ""

Though not recommended, you can also mount the ownCloud server
o using HTTP, leaving the connection unencrypted. If you plan to use

HTTP connections on devices while in a public place, we strongly

recommend using a VPN tunnel to provide the necessary security.

An alternative command syntax is:

net use Z: \\example.com@ssl\owncloud\remote.php\dav /user:youruser
yourpassword

Mapping Drives With Windows Explorer

To map a drive using the Microsoft Windows Explorer:

1.
2.

Migrate to your computer in Windows Explorer.

Right-click on [ Conput er] entry and select [ Map network drive.] from the drop-
down menu.

. Choose a local network drive to which you want to map ownCloud.

4. Specify the address to your ownCloud instance, followed by /remote.php/webdav.

For example:

https://example.com/owncloud/remote.php/webdav

For SSL protected servers, check Reconnect at logon to ensure

o that the mapping is persistent upon subsequent reboots. If you want
to connect to the ownCloud server as a different user, check
Connect using different credentials.
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) % Map Metwork Drive

What network folder would you like to map?

Specify the drive letter for the connection and the folder that you want to connect to:

Drive: [2: - ]
Folder: wyourserver.comyowncloud/remote.php/webdav iRg Browse...

Example: \\server\share

[¥] Reconnect at logon
[ Connect using different credentials

Connect to a Web site that vou can use to store your documents and pictures,

[ Finish ][ Cancel

5. Click the [ Fi ni sh] button.
Windows Explorer maps the network drive, making your ownCloud instance
available.

Accessing Files Using Cyberduck

Cyberduck is an open source FTP and SFTP, WebDAYV, and Amazon S3 browser
designed for file transfers on Mac OS X and Windows.

0 This example uses Cyberduck version 4.2.1.

To use Cyberduck:

1. Specify a server without any leading protocol information. For example:

“example.com®

2. Specify the appropriate port. The port you choose depends on whether or not your
ownCloud server supports SSL. Cyberduck requires that you select a different
connection type if you plan to use SSL. For example:

80 (for WebDAV)
443 (for WebDAV (HTTPS/SSL))

3. Use the More Options drop-down menu to add the rest of your WebDAV URL into
the "Path' field. For example:

remote.php/webdav
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Now Cyberduck enables file access to the ownCloud server.

Accessing public link shares over WebDAV
ownCloud provides the possibility to access public link shares over WebDAV.

To access the public link share, open:
https://example.com/owncloud/public.php/webdav

in a WebDAV client, use the share token as username and the (optional) share
password as password.

to send shares to other servers needs to be enabled in order to make

0 Settings > Administration » Sharing > Allow users on this server
this feature work.

Known Problems
Problem: Windows Does Not Connect Using HTTPS.

Solution 1

The Windows WebDAYV Client might not support Server Name Indication (SNI) on
encrypted connections. If you encounter an error mounting an SSL-encrypted
ownCloud instance, contact your provider about assigning a dedicated IP address for
your SSL-based server.

Solution 2

The Windows WebDAV Client might not support TLSv1.1 / TLSv1.2 connections. If you
have restricted your server config to only provide TLSv1.1 and above the connection to
your server might fail. Please refer to the WinHTTP documentation for further
information.

Problem: The File Size Exceeds the Limit Allowed and Cannot be Saved

You receive the following error message:
Error 0x800700DF: The file size exceeds the limit allowed and cannot be
saved.

Solution

Windows limits the maximum size a file transferred from or to a WebDAV share may
have. You can increase the value FileSizeLimitinBytes in
HKEY_LOCAL_MacHINE\SYSTEM\CurrentControlSet\Services\WebClient\Parameters by
clicking on [ Modi fy] .

To increase the limit to the maximum value of 4GB, select Decimal, enter a value of
4294967295, and reboot Windows or restart the WebClient service.

Problem: Accessing your files from Microsoft Office via WebDAV fails

Solution

Known problems and their solutions are documented in the KB2123563 article.
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Problem: WebDAV Drive in Windows Using Self-Signed Certificate

Cannot map ownCloud as a WebDAV drive in Windows using self-signed certificate.

Solution

1. Go to the your ownCloud instance via your favorite Web browser.

Click through until you get to the certificate error in the browser status line.
View the cert, then from the Details tab, select Copy to File.

Save to the desktop with an arbitrary name, for example myOwnCloud.cer.
Start, Run, MMC.

File » Add/Remove Snap-In.

Select Certificates » Add » My User Account > Finish > OK.

Dig down to Trust Root Certification Authorities, Certificates.

Right-Click Certificate > Select All Tasks > Import.

Select [ Save Cert] from the Desktop.

© ® N o ok W

_ =
— O

. Select Place all Certificates in the following Store, click [ Br owse],

. Check the Box that says Show Physical Stores.
Expand out Trusted Root Certification Authorities.
select Local Computer, click [ K] to complete the Import.

[EN
N

13. Check the list to make sure it shows up.
You will probably need to Refresh before you see it.
Exit MMC.

14. Open Browser, select Tools, Delete Browsing History.
15. Select all but In Private Filtering Data, complete.
16. Go to Internet Options, Content Tab, Clear SSL State.

17. Close browser, then re-open and test.

Problem: Upload Large Files or Upload Takes Long

You cannot download more than 50 MB or upload large Files when the upload takes
longer than 30 minutes using Web Client in Windows 7.

Solution

Workarounds are documented in the KB2668751 article.

Problem: The Network Name Cannot be Found

Error 0x80070043 "The network name cannot be found." while adding a network
drive.

Solution

Make Windows service WebClient start automatically:

Open Control Panel > Administrative Tools > Services.
Find WebClient service.

Right-click on it and choose Properties.

Select Startup type: Automatic.

Click [ OK] button.

O s W
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Or in command prompt (as Admin):

sc config "WebClient" start=auto
sc start "WebClient"

More details can be found here.

Accessing Files Using cURL

Since WebDAV is an extension of HTTP cURL can be used to script file operations.

To create a folder with the current date as name:

curl -u user:pass -X MKCOL
"https://example.com/owncloud/remote.php/dav/files/USERNAME/$(date '+%d-%b-
%YI)II

To upload a file error.log into that directory:

curl -u user:pass -T error.log
"https://example.com/owncloud/remote.php/dav/files/lUSERNAME/$(date '+%d-%b-
%Y')/error.log"

To move a file:

curl -u user:pass -X MOVE --header 'Destination:
https://example.com/owncloud/remote.php/dav/files/lUSERNAME/target.jpg’
https://example.com/owncloud/remote.php/dav/files/lUSERNAME/source.jpg

To get the properties of files in the root folder:
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curl -X PROPFIND -H "Depth: 1" -u user:pass
https://example.com/owncloud/remote.php/dav/files/lUSERNAME/ | xml_pp
<?xml version="1.0" encoding="utf-8"?>
<d:multistatus xmlns:d="DAV:" xmlns:oc="http://owncloud.org/ns" xmins:s
="http://sabredav.org/ns">
<d:response>
<d:href>/owncloud/remote.php/webdav/</d:href>
<d:propstat>
<d:prop>
<d:getlastmodified>Tue, 13 Oct 2015 17:07:45 GMT</d:getlastmodified>
<d:resourcetype>
<d:collection/>
</d:resourcetype>
<d:quota-used-bytes>163</d:quota-used-bytes>
<d:quota-available-bytes>11802275840</d:quota-available-bytes>
<d:getetag>"561d3a6139d05"</d:getetag>
</d:prop>
<d:status>HTTP/1.1 200 OK</d:status>
</d:propstat>
</d:response>
<d:response>
<d:href>/owncloud/remote.php/webdav/welcome.txt</d:href>
<d:propstat>
<d:prop>
<d:getlastmodified>Tue, 13 Oct 2015 17:07:35 GMT</d:getlastmodified>
<d:getcontentlength>163</d:getcontentlength>
<d:resourcetype/>
<d:getetag>"47465fae667b2d0feel54f5e17d1f0fl"</d:getetag>
<d:getcontenttype>text/plain</d:getcontenttype>
</d:prop>
<d:status>HTTP/1.1 200 OK</d:status>
</d:propstat>
</d:response>
</d:multistatus>

To get the file id of a file, regardless of location, you need to make a PROPFIND
request. This request requires two things:

1. A PROPFIND XML element in the body of the request method.
2. The path to the file that you want to find out more about

Here’s an example PROPFIND XML element, which we’ll store as propfind-fileid.xml.

<?xml version="1.0"?>

<a:propfind xmins:a="DAV:" xmIns:oc="http://owncloud.org/ns">
<!-- retrieve the file's id -->
<a:prop><oc:fileid/></a:prop>

</a:propfind>
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You could pass this directly to the Curl request. However, it can often
o be easier to create, maintain, and to share, if it’s created in a
standalone file.

With the file created, make the request by running the following Curl command:

curl -u username:password -X PROPFIND \
-H "Content-Type: text/xml" \
--data-binary "@propfind-fileid.xml" \
'http://localhost/remote.php/dav/files/admin/Photos/San%20Francisco.jpg'

This will return an XML response payload similar to the following example. It contains
the relative path to the file and the fileid of the file.

<?xml version="1.0"?>
<d:multistatus xmlns:d="DAV:" xmlIns:s="http://sabredav.org/ns"
xmlns:cal="urn:ietf:params:xml:ns:caldav" xmlns:cs="http://calendarserver.org/ns/"
xmins:card="urn:ietf:params:xml:ns:carddav" xmlns:oc="http://owncloud.org/ns">
<d:response>
<d:href>/remote.php/dav/files/admin/Photos/San%20Francisco.jpg</d:href>
<d:propstat>
<d:prop>
<oc:fileid>4</oc:fileid>
</d:prop>
<d:status>HTTP/1.1 200 OK</d:status>
</d:propstat>
</d:response>
</d:multistatus>

The example above’s been formatted for readability, using xmllint,
o which is part of libxml2. To format it as it is listed above, pipe the
previous command to xmllint --format -.

Uploading Files to a Public Link (File Drop) Using cURL

To upload a file file.txt to a public link with token 70mX9s7KOZwfmdi
https://example.com/s/70mX9s7KOZwfmdi
having no password

curl =k -T file.txt -u "70mX9s7KOZwfmdi:" -H 'X-Requested-With: XMLHttpRequest'
\https://fexample.com/public.php/webdav/file.txt

Sharing Files

Introduction

Clicking the share icon on any file or folder opens the Details view on the right, where
the Share tab has focus.
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Sharing Status Icons

Any folder that has been shared is marked with the Shared overlay icon. Public link
shares are marked with a chain link. Un-shared folders are blank.

- Documents

event-Photos & Shared
. . Photos
projecti «<} Shared

If your ownCloud server is the Enterprise edition, you may also have access to
Sharepoint and Windows Network Drive file shares. These have special status icons.
An icon with a red plugin and background means you have to enter a login to get
access to the share.

Protected Windows Normal
Network Drive Sharepoint Drive

g

Protected
Sharepoint Drive

Creating Shares

To share a file or folder, immediately below the Share tab, you will see a text field. In
this field, you can enter any number of users (whether local to your ownCloud server
or remote) or groups who you would like to share the file or folder with.

If username auto-completion is enabled, when you start typing the user or group name
ownCloud will automatically complete it for you, if possible.
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From 10.0.8, user and group name search results are dependent on a
new configuration setting, called user.search_min_length (it is set to 4
by default). This setting helps to aid search performance but requires

0 that search terms contain at least the defined number of characters.
Consequently, search terms shorter than the defined number of
characters will not return a list of matches. However, they will return
an existing user or group with a name of the same length as the search
term.

After a file or folder has been shared, Share Permissions can be set on it. In the image
below, you can see that the directory "event-Photos" is shared with the user "pierpont”,
who can share, edit, create, change, and delete the directory.

# + 7 *
event-Fhotos & Shared

Photos event-Photos

S

189 kB, 39 minutes ago

A

project1 «4 Shared Activities Sharing

beach_stump

pierpont

crabpots
notify by email

¥ can share & canedit ~

crooked_river_bend ¥ create ™ change [ delete

ghost_trees ¥ share link

http://localhost/fowncloud/index.p

A E R

grebe Password protect

7 allow editing

brandon@example.com

Send

Set expiration date

~ You can navigate directly to the sharing pane for a file by using the
O URL: https://your.owncloud.domain/f/?<$fileld>?details=shareTabView,

- and substituting <$fileld> for the file’s id.

What Happens When Share Recipients Move Files and Folders?

If a share recipient has "can edit" privileges and moves files or folders out of the
share, ownCloud stores a backup copy of the moved file/folder in the Deleted Files
(Trash) of the share’s owner. The user who moved the file/folder out of the share still
has the original copy there, along with its attached metadata.

That way, the files/folders are not permanently lost. By clicking the [ Rest or e] link,
next to the respective file or folder, ownCloud will restore these files/folders to their
original location.
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saml_2.0_sso-renamed 16 minutes ago

o Restoring files restores the backup copy for all users, including the
user that originally moved them, into the original folder.

Sharing Files with Guest Users

Users can also share files and folders with guest users. To do so, your ownCloud
administrator will need to have installed the Guest application.

If it’s already installed, in the User and Groups field of the Sharing panel, type the
email address of a user who is not already a user in your ownCloud installation. You
will then see a popup appear with the suffix (guest), as in the screenshot below.

Comments Sharing

User and Groups Public Links

user@example.com| 1

o user@example.com (remote)

o Add user@example.com (guest)

After you do that, the content will be shared with the user with all permissions
applied, except for the ability to share with other users.
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Comments Sharing

User and Groups Public Links

Share with users, groups or remote users... l

o user@example.com canshare [ canedit ~ ]

0 Guest users can also use the Desktop/I0OS/Andriod Sync Clients to
access synced files locally.

Updating Shares

To change any of the properties of a share, again, you first need to view the Share tab.
From there, you can:

* Delete a user’s access to a share

* Give more users access to a share

* Change a user’s share permissions

e Add or remove password protection

* Set or remove a share’s expiration date

This functionality is already described in other parts of this documentation and won’t
be specifically covered here.

Deleting Shares

Despite the name of this section, you don’t actually delete a share. Rather what you do
is remove the access of user’s to whom it’s already been shared with. When all users
access to a shared resource has been removed, the resource is no longer shared.

To do that, you need to click on the [ r ubbi sh bi n] icon, on the far right-hand side of
the name of each user it’s been shared with, who should no longer have access to it.

Renaming Shares

Both the sharer and all share recipients can rename a share at any time. However,
when one user renames a share, it only renames their version; no other users see the
new share name. Essentially, the share name remains the same for all other users.

In case that’s a little unclear, step through the following scenario:
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User Jenny creates a directory called "Growth Projects 2019" and
shares it with James, Peter, and Sarah. A week later, James
renames the share to "Growth Projects 2019 — Draft!". James
sees the share with the new name, but Jenny, Peter, and Sarah
continue seeing the share with its original name ("Growth Projects
2019").

This feature may seem a little strange; however, it provides flexibility for all users to
manage their files and folders as they see fit.

Password Protecting Files

It’s also possible to password protect shared files and folders. If you want to do so,
then you need to enable this functionality. Specifically, click the checkbox labeled
[ Password protect] under the "Share Link" section.

When you do so, you’ll see a password field appear. In there, add the password that
the user will need to enter to access the shared resource and press the return key.

Using Private Links

Another way to access a file or folder is via a private link. It's a handy way of creating
a permanent link for yourself or to point others to a file or folder, within a share, more
efficiently. To access the private link, in the Sharing Panel for a file or folder, next to its
name you’ll see a small link icon (1), as in the screenshot below.

8 ownCloud Manual.pdf

http://localhost/index.php/f/7 =

9 days ago

9 days ago

9 days ago Activities  Comments Sharing Versions
User and Groups Public [inks

i

If you click it, a new textbox will appear above the "Collaborative tags" field,
populated with the link’s URI (2).
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o Only people who have access to the file or folder can use the link.

Changing The Share Expiration Date

You can set an expiration date on any of user, group, federated and public link shares.
The administrator may have set a default expiration for shares. If so, then new shares
will have the default expiration. You may adjust or remove the expiration date.

The administrator may have enforced the default expiration to be the maximum
expiration. In that case, you must set an expiration date less than or equal to the
maximum.

The share will expire at the end of the specified expiration date. Users of the share will
no longer be able to access it.

Creating or Connecting to Federation Share Links

Federated Cloud Sharing allows you to mount file shares from remote ownCloud
servers, and manage them just like a local share. In ownCloud 8 the process for
creating a new sharing link is easier and more streamlined. See Using Federation
Shares to learn to how to create and connect to new Federated Cloud shares.

Share Permissions

Shares can have a combination of the following five permission types:

Permission Definition

can share Allows the users you share with to re-share

can edit Allows the users you share with to edit your shared files, and to
collaborate using the Documents app

create Allows the users you share with to create new files and add them to
the share

change Allows uploading a new version of a shared file and replacing it

delete Allows the users you share with to delete shared files

Creating Drop Folders

As of ownCloud version 10.0.2, users can create upload-only, public shares (otherwise
known as "Drop Folders"). Drop Folders allow users to upload files to a central
location, but don’t allow them to either see or change any existing files, which already
have been uploaded.
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L] Name =

X
Edit link share: /test b
Link Name
kest link :
M Allow editing .

Show file listing

Password

Expiration

m Cancel

To create one:

1. View the sharing panel of the folder that you want to share as a Drop Folder, select
Public Links > Create public link.

2. As with other shares, provide the name in the "Link Name" field.

3. Check [Al | ow editing], un-check [ Show file listing], and then un-check
[Al'l ow editing].

4. Finally, click [ Save] to complete creation of the share.

Now, as with other public links, you can copy the link to the share and give it out, as
and when necessary.

Using Drop Folders
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When users open the share link, they will see a page where they can either click to
select files to share, or drag-and-drop files directly to share them. After the file’s been
successfully uploaded, they’ll see (where possible) a preview of the file that has been
uploaded.

Search & Full Text Search

Introduction

ownCloud comes with a regular search function allowing you to find files by their file
name or parts of it. Click on the the magnifier icon in the upper right-hand corner of
the web interface. In addition, the Full Text Search app can be enabled. This is
something the system administrator needs to take care of. For more information on
deploying it, refer to the respective section in the Admin Manual.

Regular Search

The regular search function in the ownCloud web interface offers a simple search for
elements of file names. This also works when you only enter "pain" but meant to look
for Spain. However, you also get results for pain or painful. If you start at the top level
"All files", you will also see results in subfolders. If you change into a directory, the
search starts in this folder, displays the results, then continues to search in all other
folders.

A click on one of the results takes you either to the location of the file, if you are not
already in that folder, or the item is opened.

The search is not case-sensitive, so capital letters are treated the same as lower case
characters. You can type Spain or spain and will get the same results. When you start
typing, the search also starts.

Full Text Search App

Things get tricky when you don’t remember what the file you’'re looking for was called
and guess work doesn’t help. A key word search within text documents is only possible
if the Full Text Search app is installed. Contact your admin if you need it and it’s not
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installed. With this app enabled, you can search within files of the most common
formats. Like with the regular search, you can enter only the first part of a string and
it matches all occurances of words starting with the search string.

If you are looking for all terms containing a specific string like in the above example
"pain", wildcards can be used, e.g. an asterisk: *ain gives you results like braine, pain,
Spain and painful. Using a question mark instead of the asterisk limits the preceeding
characters to exactly one. In this example, only pain and painful would show up if you
entered the search string "?ain".

(r) Using the asterisk within a word will ignore everything that follows
w after the asterisk. A trailing asterisk is always assumed in the search.

Tagging Files
Introduction

In ownCloud, you can assign one or more tags to files and folders. To do so, go to the
"Details" view in the The Overflow Menu and enter the "Tags" tab.

#* + Welcome t
welcometxt &

This is just

The packa,

s welcome 2days ago

There, you’ll see a text field with the placeholder text "Collaborative tags" if no tags
have been added yet.

In that field, type the tag’s name. If you want to use multiple words, there is no need
to use single or double quotes. Type as many words as you want for the tag name.
When you press the return key, your tag will be saved.

e All tags are collaborative tags, so they are shared by all users on your
ownCloud server.
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When you place the cursor inside the tags field and as you type the tag name, a list of
the collaborative tags will appear. If you type a new tag name, the visible tags list will
be filtered based on the text you've entered.

If you see a tag in the list which is what you had intended to type or is a better fit than
what you had in mind, click on it, and it will be added to the file or folder’s tag list.
This can save you a lot of time and effort.

0 The assigned tags are also visible in the "Details" view under the file
name. When you click on a tag, the "Tags" tab will open.
Untag a File or Folder

If a file or folder is already tagged, the tags assigned will have a check mark in the
dropdown list, to the left of the tag’s name. To remove that tag from the file or folder,
click the tag’s name. You will see that the check mark disappears.

Edit Tags

To edit a tag, click the pencil icon on the right-hand side of the tag’s name in the tags
list. This will display a text box containing the tag’s name. Be sure that you want to
change the tag’s name since it will be updated for all users.

Delete Tags

To delete a tag, click the trash can icon on the far right-hand side of the tag in the
dropdown list. This removes the tag from the collaborative tags list. As with renaming
a tag, keep in mind that deleting a tag removes it for all users. So be sure that you
want to do this.

Filter by Tag

To filter by tag, use the Tags filter on the left sidebar of the Files page. There are
three types of tags:

Tag Description

Visible All users may see, rename, and apply these tags to files and folders

Files | 47



Tag Description

Restricted Tags are assignable to and editable by only the users and groups
which have permission to use them. Other users can filter files by
restricted tags, but cannot tag files with them or rename them. The
tags are marked (restricted)

Invisible Visible only to ownCloud admins

When you use the Tag filter on your Files page, you'll see something like the following
image. If you do not have Admin rights, you will not see any invisible tags.

mehtag
newtag (invisible)

oldtag (restricted)

Encrypting Your ownCloud Files

Introduction

ownCloud includes an Encryption app, and when it is enabled by your ownCloud
administrator all of your ownCloud data files are automatically encrypted. Encryption
is server-wide, so when it is enabled you cannot choose to keep your files unencrypted.
You don’t have to do anything special, as it uses your ownCloud login as the password
for your unique private encryption key. Just log in and out and manage and share your
files as you normally do, and you can still change your password whenever you want.

Its main purpose is to encrypt files on remote storage services that are connected to
your ownCloud server, such as Dropbox and Google Drive. This is an easy and
seamless way to protect your files on remote storage. You can share your remote files
through ownCloud in the usual way, however you cannot share your encrypted files
directly from Dropbox, Google Drive, or whatever remote service you are using,
because the encryption keys are stored on your ownCloud server, and are never
exposed to outside service providers.

If your ownCloud server is not connected to any remote storage services, then it is
better to use some other form of encryption such as file-level or whole disk encryption.
Because the keys are kept on your ownCloud server, it is possible for your ownCloud
admin to snoop in your files, and if the server is compromised the intruder may get
access to your files. (Read How ownCloud uses encryption to protect your data to
learn more.)

Using Encryption

ownCloud encryption is pretty much set it and forget it, but you have a few options you
can use.

When your ownCloud admin enables encryption for the first time, you must log out and
then log back in to create your encryption keys and encrypt your files. When
encryption has been enabled on your ownCloud server you will see a yellow banner on
your Files page warning you to log out and then log back in.
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Encryption App is enabled but your keys are not initialized, please log-out and log-in again

When you log back in it takes a few minutes to work, depending on how many files you
have, and then you are returned to your default ownCloud page.

nitial encrypuon started... This can

o
" take some time. Please wait.

stashcat

You must never lose your ownCloud password, because you will lose

o access to your files. However, there is an optional recovery option that
your ownCloud administrator may enable; see the Recovery Key
Password section (below) to learn about this.

Which Data Is Encrypted and When

The following data is encrypted:

* Users' files in their home directory trees if enabled by the admin.
Location: data/<user>/files, see the: occ encryption command set

* External storage if enabled either by the user or by the admin

The following is never encrypted:

* File names or folder structures

» Existing files in the trash bin

» Existing files in Versions

* Image thumbnails

* Previews from the Files app

* The search index from the full text search app

* Third-party app data
Note that there may be other not mentioned files that are not encrypted.

When are files encrypted

If not otherwise decided by the admin, only new and changed files after enabling
encryption are encrypted.

o An admin can encrypt existing files post enabling encryption via an occ
encryption command.
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Sharing Encrypted Files

Only users who have private encryption keys have access to shared encrypted files and
folders. Users who have not yet initialized their private encryption keys will not have
access to encrypted shared files; they will see folders and filenames, but will not be
able to open or download the files. They will see a yellow warning banner that says:

"" Encryption App is enabled but your keys are not initialized, please log-out and log-in
again.” ""

Share owners may need to re-share files after encryption is enabled; users trying to
access the share will see a message advising them to ask the share owner to re-share
the file with them. For individual shares, un-share and re-share the file. For group
shares, share with any individuals who can’t access the share. This updates the
encryption, and then the share owner can remove the individual shares.

Recovery Key Password

If your ownCloud administrator has enabled the recovery key feature, you can choose
to use this feature for your account. If you enable "Password recovery" the
administrator can read your data with a special password. This feature enables the
administrator to recover your files in the event you lose your ownCloud password. If
the recovery key is not enabled, then there is no way to restore your files if you lose
your login password.

Encryption

Enable recovery key (allow to recover users files in case of password loss):

-------- Recovery key password

-------- Repeat Recovery key password

* Enabled
Disabled

Change Private Key Password

This option is only available if your log-in password, but not your encryption password,
was changed by your administrator. This can occur if your ownCloud provider uses a
external user back-end (for example, LDAP) and changed your login password using
that back-end configuration. In this case, you can set your encryption password to
your new login password by providing your old and new login password. The
Encryption app works only if your login password and your encryption password are
identical.

Managing Deleted Files

Introduction

When you delete a file in ownCloud, it is not immediately deleted permanently.
Instead, it is moved into the trash bin. It is not permanently deleted until you manually
delete it, or when the Deleted Files app deletes it to make room for new files.

Find your deleted files by clicking on the [ Del et ed fil es] button on the Files page of
the ownCloud Web interface. You’ll have options to either restore or permanently
delete files.
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Quotas

Deleted files are not counted against your storage quota. Only files that originate with
users count against their quotas, not files shared with them that originate from other
users. (See webgui/quota to learn more about quotas.)

What Happens When Shared Files Are Deleted

Deleting files gets a little complicated when they are shared files, as this scenario
illustrates:

1. Userl shares a folder "test" with User2 and User3
2. User2 (the recipient) deletes a file/folder "sub" inside of "test"

3. The folder "sub" will be moved to the trashbin of both Userl (owner) and User?2
(recipient)

4. But User3 will not have a copy of "sub" in her trash bin

When Userl deletes "sub" then it is moved to Userl’s trash bin. It is deleted from
User?2 and User3, but not placed in their trash bins.

When you share files, other users may copy, rename, move, and share them with other
people, just as they can for any computer files; ownCloud does not have magic powers
to prevent this.

How the Deleted Files app Manages Storage Space

To ensure that users do not run over their storage quotas, the Deleted Files app
allocates a maximum of 50% of their currently available storage quota to deleted files.
If your deleted files exceed this limit, ownCloud deletes the oldest files (files with the
oldest timestamps from when they were deleted) until it meets the memory usage limit
again.

ownCloud checks the age of deleted files every time new files are added to the deleted
files. By default, deleted files stay in the trash bin for 180 days. The ownCloud server
administrator can adjust this value in the config.php file by setting the
trashbin_retention_obligation value. Files older than the trashbin_retention_obligation
value will be deleted permanently. Additionally, ownCloud calculates the maximum
available space every time a new file is added. If the deleted files exceed the new
maximum allowed space ownCloud will expire old deleted files until the limit is met
once again.

Large File Uploads

When uploading files through the web client, ownCloud is limited by PHP and Apache
configurations. By default, PHP is configured for only 2 megabyte uploads. As this
default upload limit is not entirely useful, we recommend that your ownCloud admin
increase the ownCloud variables to sizes appropriate for users.

Modifying certain ownCloud variables requires administrative access. If you require
larger upload limits than have been provided by the default (or already set by your
administrator):

* Contact your administrator to request an increase in these variables

* Refer to the section in the Admin Documentation that describes how to manage file
upload size limits.
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Manual File Locking

Introduction

Manual file locking allows users, if enabled by the ownCloud administrator, to lock
files in shared areas while working on them in order to prevent concurrent changes
from other users (check-in/check-out).

All storages are supported as locking takes place on the WebDAYV level. The locks will
only be available via ownCloud, not when a user works directly on the storage. Using
the context menu of files, every user who has access can lock them. Users can
recognize locked files by the means of a new lock indicator. While a file is locked,
other users can still access it but they cannot make any changes. Locked files can
manually be unlocked by the lock owner (the user who locked the file; exclusive
locking) using the "Locks" tab in the file details view (right sidebar).

Using Manual File Locking

The user-facing components in the web interface are disabled by
default and must be enabled by the ownCloud administrator, because

o this feature allows users to lock other users files exclusively. Lock
releasing can only be done by the locking user, a user who is a member
of a lock breaking group (if defined by the ownCloud administrator) or
until the lock expires.

By default, locks set by the user in the web interface will expire after 30 minutes, the
maximum lock time by default is 24 hours. Both values can be changed by the
ownCloud administrator.

When the owncloud administrator has enabled Manual File Locking, the user will see
additional menu items and icons in the files view.

Manual Locking Disabled Manual Locking Enabled
%+ TestFolder + 3 TestFolder +
™= test_file my‘m;“_:‘ test_file txt
1 1
4 £
+ +
& C & Cop)

If manual locking is enabled, the following additional user-facing components are
present.
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File Lifecycle Management

Introduction

With File Lifecycle Management, ownCloud provides a toolset for administrators to
automatically move user files into a dedicated archive a certain time after they were
uploaded. Unless they are restored, archived files will be permanently deleted once
they exceed a certain time in the archive. The following sections provide guidance for
users on ownCloud installations that have File Lifecycle Management policies enabled.

@ Only files will be archived, folder structures are kept available.

Archiving Process

To see when and if files are scheduled for archiving, a user may select a file within the
files list to open the detail view in the sidebar. In the sidebar, they can see the
remaining days until it will be automatically archived. Archiving usually takes place
once a day. When a file is due to be archived, it will show 'Scheduled for archive
today!".
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Portugal.jpg
v 238 KB, a month ago
Scheduled for archive in 7 days

Collaborative tags

Activities Comments Sharing Versions

-4 You created Portugal.jpg
2 minutes aga

Depending on the policy configuration, users may be able to restore their own files
using a file action in the file list.

Whilst a file is in the archive, it cannot be used in the Web interface or with the
ownCloud Clients, but can be located using the archive browser. Existing metadata

including shares, comments and tags are preserved, but will not be available for
archived files.

Browsing the Archive

Users can browse the archive in a similar fashion to the 'Deleted Files', using the
'Archived Files' file list available on the bottom left of the files view. Folder structures
are recreated showing the paths that were present at the time a file was archived.
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B  Archived Files
W Deleted files
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Restoring Files

Depending on the policy configuration, users may be able to restore files on their own
in 'Archived Files' by clicking the 'Restore' action on the file or folder row. Specific
policies may require different permissions to access this option, or permanently
disable it. Restored files can be used for the same amount of time as if they were
uploaded before they will be archived again.

Activities

File Lifecycle Management events (like archiving/restoring a file) are added to the
Activity history. These can be viewed within the 'Activity' tab in the sidebar or within
the Activity Stream. Within the personal settings page, users can choose to receive e-
mails related to these events.
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Teotihuacan.jpg

W 223 KB, a month ago

Scheduled for archive in a day

Collaborative tags

Activities Comments Sharing Versions

I Teotihuacan.jpg was restored

7 days ago
I Teotihuacan.jpg was moved to the archive

7 days ago
+ You created Teotihuacan.jpg

3 days ag

Public Link Shares

With ownCloud X (10.0), we introduced the ability to create multiple public links per
file or folder. This offers a lot of flexibility for creating different kinds of share links for
a single file or folder, such as different passwords, expiry dates, and permissions.

As of ownCloud version 10.0.2 you can create Drop Folders, where users can upload
files to a central location, but not be able to change any existing ones, nor see other
files which already have been uploaded.

Creating Public Link Shares

To create a public link share, first view the Sharing Panel of the file or folder that you
want to create a public link share for. Then, click the [ Publ i ¢ Li nks] button, and then
click [ Create public Iink].After you do, the public link share dialog will appear,
which you can see below.
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Photos

< % 663 KB, 2 months ago

Collaborative tags

Activities Comments Sharing

User and Groups Public Links

There are currently no link shares, you can
create one

Create public link

Anyone with the link has access to the
file/folder

As with other shares, provide the name in the "Link Name" field, and fill out the
options that suit what you want the link to support. You can find details of what each
option does below.
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Edit link share: /Photos
Link name

Public link

0 Download / View

|“.i‘E||:'I'Z’|'.5 can view or aownload contents.

Download / View / Edit

Recipients can view, download and edit contents.

Download / View / Upload

|‘\.£‘EI|I'I':’|'.S can view, download and upload contents.

Upload only (File Drop)

Receive files from multiple recipients without revealing the contents of the folder.

Password

Expiration

Cancel Remove password m

Finally, click the [ Save] button to complete creation of the share. Now that the share
is created, you can:

* Copy the link to the share and give it out

Update the share’s settings

e Share the link via social media and email
* Delete the public link

Share

Settings Explained

Setting Description

Download / Allows recipients to view or download the public link’s contents.

View

Download / Allows recipients to view, download, edit, and delete the public link’s

View

/ Edit contents.

Download / Allows recipients to view, download and upload the public link’s

View

/ Upload contents.
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Setting Description

Upload only  Allows users to create a drop folder, which can receive files from
(File Drop) multiple recipients without revealing the contents of the folder.

Password Sets a password for protecting the link.

Expiration Sets an expiry date for the link. The public link expires at the end of
the specified day.

Using Federation Shares

Introduction

Federation Sharing allows you to mount file shares from remote ownCloud servers, in
effect creating your own cloud of ownClouds. You can create direct share links with
users on other ownCloud servers.

o Federated Sharing has to be configured by the administrator.

How Federated Sharing Works

Federated sharing, conceptually, is not that sophisticated a concept. Here’s how it
works.

Say we have three users: James, Mary, and Paul. James has a folder (Majorca-Holiday-
Pics) which he shares with Mary, who’s on a separate ownCloud instance. Mary, in
turn, (re)shares the folder with Paul, who’s on the same ownCloud instance as Mary.

You might think that there are two — even three — copies of the shared folder. In
reality, there’s only one. In effect, there are three — all owned by the original sharer
(James).

The key point to keep in mind is that when a share is re-shared, it’s shared, internally,
on behalf of the original owner. To keep track of all this, during the share process
references are created between the shares, that show:

* James was the original owner of the shared resource

* James shared a copy with Mary and Mary re-shared a copy with Paul.

Creating a New Federation Share

Federation sharing is enabled on new or upgraded ownCloud installations by default.
Follow these steps to create a new share with other ownCloud 9 servers:

1. Go to your Files page and click the [ shar e] icon on the file or directory you want
to share. In the sidebar enter the username and URL of the remote user in this
form: <username>@<oc-server-url>. In this example, that is layla@remote-
server/owncloud. The form automatically echoes the address that you type and
labels it as "remote". Click on the label.
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2. When your local ownCloud server makes a successful connection with the remote
ownCloud server you’ll see a confirmation. Your only share option is Can edit.

Click the Share button anytime to see who you have shared your file with. Remove

your linked share anytime by clicking the trash can icon. This only unlinks the share,
and does not delete any files.

Creating a New Federated Cloud Share via Email
Use this method when you are sharing with users on ownCloud 8.x and older.

What if you do not know the username or URL? Then you can have ownCloud create
the link for you and email it to your recipient.
Share link
httpy/ubuntu2/owncloud/index.php/s/ujh 7VbEFUWXIGuU
[ | Password protect
friend@example.cnm| Send

[] Set expiration date

When your recipient receives your email they will have to take a number of steps to
complete the share link. First they must open the link you sent them in a Web browser,
and then click the [ Add to your ownC oud] button.

Add to your ownCloud

¥ Download nebula-3.jpg (7 kB)

Direct link | http#/ubuntu2fowncloud/index.php/s/OATwCoQt

The Add to your ownCloud button changes to a form field, and your recipient needs
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to enter the URL of their ownCloud server in this field and press the return key, or
click the arrow.

Jote-server/owncloud = <+ Download

Next, they will see a dialog asking to confirm. All they have to do is click the [ Add
renot e share] button and they’re finished.

Remove your linked share anytime by clicking the [trash can] icon. This only unlinks
the share, and does not delete any files.

Limitations

Sharing to groups from federated ownCloud instances is not supported.

Session Management

Introduction

The personal settings page allows you to have an overview of the connected browsers
and clients. It is accessed by selecting the Settings > Personal > Security.

Sessions
Sessions
These are the web, desktop and mobile clients currently logged in to your ownCloud.
Browser Most recent activity
Mozilla/5.0 (Windows NT 10.0; Winé4; x64) AppleWebKit/537.36 (K... 2 minutes ago
Mozilla/5.0 (i0S) ownCloud-i05/3.8.0 4 minutes ago [ ]

Mozilla/5.0 (Windows) mirall/2.5.2 (build 11181) 3 minutes ago [ ]

The sessions list shows which browsers and clients were recently, and are actively
connected to your ownCloud installation. You can use the trash icon, at the far right-
hand side of any session, to terminate it.

Please Be Aware of Two Things

1. If you want to lock out a user, you need to change their password before you
terminate their session.
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2. The currently logged-in user cannot terminate their own session from the sessions
list.

App Passwords

App passwords / tokens

You've linked these apps.

Name Most recent activity

Client seconds ago

L[}

App passwords or tokens are passcodes that give an app or device permissions to access your ownCloud account.
Use them as a security measure to hide your actual password which you may only want to use for web interface login.
Use the credentials below to configure your app or device.

Username admin

Password / Token  SBILI-VXEEM-JXCXX-QBSJ1J Done

Underneath the "App passwords / tokens" list is a button to create a new app or
device-specific username and password. The username will be pre-filled to the
currently logged in user, and a random password will be generated. You can change
both of these, if so desired. When you’re happy with the username and password, click
the [ done] button. You can use the trash icon, at the far right-hand side of any
password, to delete it

o Once the password / token is created, it cannot be changed; it can
only be deleted.

- We recommend that you generate tokens for every device you want to
O connect to your ownCloud instance, as this will allow you to disconnect

- connections individually, if necessary.

Version Control

Introduction

ownCloud supports a simple version control system for files. Versioning creates
backups of files which are accessible via the Versions tab on the Details sidebar. This
tab contains the history of the file where you can roll back a file to any previous
version. Changes made at intervals greater than two minutes are saved in
data/[user]/versions.
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You can navigate directly to the versions pane for a file by using the

(r') URL:

w https://your.owncloud.domain/f/?<$fileld>?details=versionsTabView, and
substituting <$fileld> for the file’s id.

To restore a specific version of a file, click the [ ci rcul ar arrow] to the left. Click on
the [ti nest anp] to download it.

The versioning app expires old versions automatically to make sure that the user
doesn’t run out of space. The following pattern is used to delete old versions:

» For the first second we keep one version

* For the first 10 seconds ownCloud keeps one version every 2 seconds

* For the first minute ownCloud keeps one version every 10 seconds

* For the first hour ownCloud keeps one version every minute

* For the first 24 hours ownCloud keeps one version every hour

» For the first 30 days ownCloud keeps one version every day

» After the first 30 days ownCloud keeps one version every week
The versions are adjusted along this pattern every time a new version gets created.

The version app never uses more that 50% of the user’s currently available free space.
If the stored versions exceed this limit, ownCloud deletes the oldest versions until it
meets the disk space limit again.

Online Collaboration

Collabora Online

Collabora Online is a powerful LibreOffice-based online office that supports all major
document, spreadsheet and presentation file formats, and is integrable with
ownCloud.

Secure View

Secure View is a way to securely distribute information, without that information
being able to leave your organisation. It provides the ability to restrict access to
documents, in read-only shares, so that recipients cannot copy, download, or edit
shared files.
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When enabled, documents will be viewed through Collabora Online with a watermark.
In addition, the ability to print and export files (with watermarks) is available, once
Secure View is enabled.

o This feature is not available in the community edition, or for Public
Links.

How to Use Secure View

Comments Sharing

User and Groups Fublic Links

Share with users or groups...

o editor can share can edit -

Secure View (with watermarks) can print / export PDF

To enable Secure View for an existing, or new, share:

* enable [ Secure View (w th wat er marks)]

* enable[can print / export PDF] (optional). This allows documents to be printed
and exported through Collabora Online.

"can edit" and "Secure View (with watermarks)" are mutually exclusive.
o If "can edit" is enabled and a user enables "Secure View (with
watermarks)", then "can edit" is automatically disabled.
When "Secure View (with watermarks)" is enabled, any attempts to download the file
will be blocked, as exemplified in the screenshot below. Additionally, select, copy, and
paste are disabled.

-’\
é
o,

ownC

Access denied
Access denied: File, folder or one of the files inside the folder cannot be downloaded

Storage Quotas

Introduction

Your ownCloud admin has the option to set a storage quota on users. Look at the top of
your Personal page to see what your quota is, and how much you have used.
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You have used 70.6 MB of the available 5 GB

It may be helpful to understand how your quota is calculated. Metadata (thumbnails,
temporary files, cache, and encryption keys) takes up about 10% of disk space, but is
not counted against user quotas. Some apps store information in the database, such as
the Calendar and Contacts apps. This data is excluded from your quota.

When other users share files with you, the shared files count against the original share
owner’s quota. When you share a folder and allow other users or groups to upload files
to it, all uploaded and edited files count against your quota. When you re-share files

shared with you, the re-share still counts against the quota of the original share owner.

Encrypted files are a little larger than unencrypted files; the unencrypted size is
calculated against your quota. Deleted files that are still in the trash bin do not count
against quotas. The trash bin is set at 50% of quota. Deleted file aging is set at 30
days. When deleted files exceed 50% of quota then the oldest files are removed until
the total is below 50%.

When version control is enabled, the older file versions are not counted against
quotas. If you create a public link share via URL, and allow uploads, any uploaded files
count against your quota.

Quotas Are Neither Hard Nor Soft

Quotas are not strictly hard quotas, but nor are they soft quotas either. They’re more
hard quotas with the exception of always being able to restore deleted files.

Why? Well, say that a user’s Trash bin contains one or more files. The user uploads
several files and in the process reaches their quota limit.

If hard quotas were enforced, the user would be prevented from being able to restore
any deleted file. However, with the Trash bin exception in place, files can always be
restored, but no new files can be uploaded, once a quota has been reached.

This user workflow may sound peculiar, but not allowing a user to restore files would
make for a poor user experience. Given that, this exception is allowed.

Configuring External Storage

The External Storage application allows you to mount external storage services, such
as Google Drive, Dropbox, Amazon S3, SMB/CIFS fileservers, and FTP servers in
ownCloud. Your ownCloud server administrator controls which of these are available
to you. Please see External Storage Configuration in the ownCloud Administrator’s
manual for configuration howtos and examples.

Connecting to SharePoint (Enterprise only)

Introduction

Native SharePoint support has been added to ownCloud Enterprise Subscription as a
secondary storage location for SharePoint 2007, 2010 and 2013. To the user, these
appear as normal ownCloud mounts, with bi-directional updates in any ownCloud
client: desktop, mobile, or Web.

There is one difference, and that is ownCloud sharing is intentionally disabled for
SharePoint mountpoints in order to preserve SharePoint access controls, and to ensure
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that content is properly accessed as per SharePoint rules. Your ownCloud admin may
optionally allow users to mount their own SharePoint libraries.

Accessing SharePoint Folders

When you first log in to ownCloud, the Web interface shows a gray bar behind all
SharePoint folders. The gray bar disappears when the mountpoint is verified by the
server. If you see a red error bar, you’ll see either an hourglass that indicates a
connection error, or a key to indicate that authentication is required.

Your ownCloud admin has the option to configure SharePoint credentials so that you
are authenticated automatically, or you may be required to enter your credentials. If
you have to enter your credentials, click the [red bar] and you’ll get a login window.
You should only have to do this once, as ownCloud will store your credentials.

If your SharePoint login ever changes, go to your Personal page to update it in the
Sharepoint Personal Configuration section.

Personal Page

You can manage your SharePoint connections in the Sharepoint Personal Configuration
section of your ownCloud Personal page. You'll see two sections: the Admin added
mount points section lists SharePoint mounts controlled by your ownCloud admin. If
users have permissions to mount their own SharePoint libraries you’ll also see a
Personal mount points section.

There are two types of authentication available to you. If you have multiple SharePoint
libraries that use the same authentication, enter your credentials in Sharepoint
Personal Configuration. Then follow these steps to add your libraries:

* Enter the name of your local mountpoint in the Local Folder Name column.
* Enter your SharePoint server URL.

* Click the little refresh icon to the left of the Document Library field. If your
credentials and URL are correct you’ll get a dropdown list of SharePoint libraries to
choose from.

* Select the document library you want to mount.
* Select "Use user credentials".

* Click the [ Save] button, and you’re done

You may elect to use different authentication credentials for some of your SharePoint
libraries. For these, you must first select use custom credentials, and then fill in the
mountpoint and SharePoint site URL. Then ownCloud can authenticate you, and you
can click the [ refresh] icon to see your libraries. Then select the library you want to
mount and click the [ Save] button.

Desktop and Mobile Synchronization

For synchronizing files with your desktop computer, we recommend using the
ownCloud Sync Client for Windows, Mac OS X and Linux.

The ownCloud Desktop Sync Client enables you to connect to your private ownCloud
Server. You can create folders in your home directory, and keep the contents of those
folders synced with your ownCloud server. Simply copy a file into the directory and the
ownCloud desktop client does the rest. Make a change to the files on one computer, it
will flow across the others using these desktop sync clients. You will always have your
latest files with you wherever you are.
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Its usage is documented separately in the ownCloud Desktop Client Manual.

Mobile Clients

Visit your Personal page in your ownCloud Web interface to find download links for
Android and iOS mobile sync clients. Or, visit the ownCloud download Mobile page.

Visit the ownCloud documentation page to read the mobile apps user manuals.
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Apps

In this section you will find all the details you need on some of the core apps available
with ownCloud.

The Activity App

Introduction

The ownCloud Activity app gathers all your file or folder related actions in one place
for you to review and can notify you about them via email as well. You can decide, in
detail, which file and folder actions are listed in the Activity stream, and for which file
or folder actions to receive email notifications. By using the app, you can ensure that
you never miss an important event related to content in ownCloud and always be up-
to-date on all activities of your files and folders.

(r') The Activity App is shipped and enabled by default. If it is not enabled,
w contact your ownCloud administrator to have it enabled.

Viewing Notifications

To view notifications, click the hamburger menu, in the top left-hand corner of the
WebUI, and then click "Activity", as you can see in the screenshot below.

-* Chared writh wnon

By default, you see all activity related to your files and folders. However, by using the
left-hand navigation menu, you can filter activity by:

* Activities by you

* Activities by others

* Favorites

e Comments

¢ Shares

All Activities

Today
Activities by you v o
e . ou commented on content-plan.adoc

This is a short comment on a file. 3 minutes ago

Favarites
Comments

S5hares
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Configuring the Activity App

To configure your Activity preferences navigate to Settings > Personal > General >
Activity. You can configure notifications for when:

* Files and folders are created, changed, deleted, restored (from the trash bin), and
shared.

* Files and folders are shared from another server.

* A publicly shared file or folder was downloaded.

* Comments are added to a file.

* System tags for a file have been modified.

To do so, enable or disable the relevant checkboxes in the Activity settings panel, as in
the screenshot below.

Activity
Tl trear
= A new file or folder has been created
] A file or folder has been changed
Limit notifications about creation and changes to your favorite files
v Afile or folder has been deleted
] A file or folder has been restored
v v Afile or folder has been shared
[+ ] A file or folder was shared from another server
[+ A public shared file or folder was downloaded
Comments for files
[+ System tags for a file have been modified

M List wyour own file actions in the stream

Maotify about your own actions via email

send emails:  Hourly =

O Sharing actions are only visible to the sharer and recipient.
-

Limiting Notifications

For users with lots of activity, it is possible to limit the Activity stream to 'Favorites' to
avoid noise.
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Activity

A new file ar folder has been created

A file or folder has been changed

Limit notifications about creation and changes to your favorite files

A file or folder has been deleted
Afile or folder has been restored
Configuring the Email Notification Interval

In addition to enabling and disabling email notifications, bulk email notifications can
be configured to be sent out: As soon as possible (during the next cron execution),
Hourly, Daily, and Weekly. To do so, pick the interval in the "Send emails:" drop-down
field at the bottom of the Activity configuration panel.

Using the Calendar App

The Calendar app is not enabled by default in ownCloud and needs to be enabled
separately. You can download it via the market app.

Using the Contacts App

The Contacts app is not enabled by default in ownCloud and needs to be enabled
separately. You can download it via the market app.

The Market App

Log in to the Marketplace From the Market App

To log in to the ownCloud Marketplace from the Market app, open the Market app by
clicking on the Market app icon in the top-level ownCloud navigation menu, which you
can see above.

= Market

m 4

Activity

Once on the Market app, click [ LOG N], located at the bottom of the left-hand side
navigation menu.

You are next asked to grant the Market app access to your Marketplace account. Enter
your Marketplace username and password and click [ LOA N] .
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Next, confirm your request to grant the Market app access to your Marketplace
account. To give this confirmation, click [ GRANT ACCESS] .

Once you’ve done this, you are redirected back to the Market app in your ownCloud
installation. The original "LOGIN" button is now greyed out and labelled "LOGGED
IN™.

The Media Viewer App

M Ale Dateien 3 +
*
< - test 287 MB wor einem Tag
< v .
G« 2016:05-17 124553
e
&
. IMG_0057
. IMG_0058
. IMG_4119 30.8 MB vor 17 Tagen
El oton_kathi jenida 2 7571 MB
Pancrama & 2011 Bergsport heute wor 10 Tagen
e
#T= vicsnap-2018-11-22-14h53m19s377
ks welcome
L3
& Cinstellungen
Introduction

The Media Viewer app is a lightweight viewer for pictures and videos which integrates
with the files app, and is released under the GPLv2. It replaces the gallery and

files videoplayer apps, which have now been deprecated, and supports the same basic
feature set as the deprecated apps.

It supports the following functionality:

* Image: preview, zoom, rotation, and download

* Video: playback and download

0 The app will support paginating through all media files in the current
directory, even if only one media file was chosen to be previewed.
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Features
* Support for a large selection of image and video formats (depending on server
setup)

* Fullscreen, zoomable slideshow view integrated with the Files view and Public
Links

* Image rotation

* Sort images by name or date

* Image and video download straight from the slideshow
* Native SVG support

e Mobile support

Supported File Formats

* The supported video formats depend on the user’s browser. However, the app
supports MP4, Ogg, and WebM.

* The supported image formats depend on the server capabilities
Use Redis for Files Locking

Using Redis for files locking improves app performance by a factor of 10, when
loading an album.

Unsupported File Formats

* Support for playing Apple QuickTime (*.mov) does not work in Chrome - however it
is supported in Safari and Mozilla.

72 | The Media Viewer App



Integration

This section is dedicated to integrating ownCloud with other products, for now only
Microsoft Teams, but more is likely to come.

e Microsoft Teams

Integrate ownCloud into Microsoft Teams

Introduction

You can access your ownCloud via Microsoft Teams if your administrator has created
an app available in your organization’s app catalog. It is possible that the admin
already has enabled the app for the users, in this case you do not need to search for it
in your organization’s app catalog as it is already pinned.

Access the App

To access the app, perform the following steps:

1. Log in to Teams.

2. Click on the overflow menu, select Apps and search for ownCloud for Teams or
the name provided by your admin.

|;:

(r') You can pin the app to your left sidebar permanently. Right-click on
- the icon and select "Pin".

3. Log in to ownCloud by clicking on Login to ownCloud with Azure AD.

e —

4. For security reasons, you need to repeat the login process after a certain idle time.

5. Repeat the steps if there is more than one ownCloud for Teams app available
accessing different ownCloud hosts.
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Contacts & Calendar

The Contacts, Calendar, and Mail apps are not included in ownCloud 9 and later, and
are not supported. You can install them from the ownCloud Marketplace by clicking

[Instal l] on their respective entries. You can find them under Market >
Productivity.

i0S - Synchronize iPhone/iPad

Calendar

Open the settings application.

Select Mail > Contacts > Calendars.

Select [ Add Account].

Select [ & her] as account type.

Select [ Add Cal DAV] account.

For server, type example.com/remote.php/dav/principals/users/USERNAME/
Enter your user name and password.

Select Next.

© © N Uk w e

If your server does not support SSL, a warning will be displayed. Select
[ Conti nue].

RN
=)

. If the iPhone is unable to verify the account information perform the following
steps:

o Select [ K] .

o Select [ Advanced Settings].

o If your server does not support SSL, make sure Use SSL is set to OFF.
o Change port to 80.

o Go back to account information and click [ Save] .

Your calendar will now be visible in the Calendar application

Address book

Open the settings application.

Select Mail > Contacts > Calendars.

Select [ Add Account].

Select Other as account type.

Select [ Add Car dDAV] account.

For server, type example.com/remote.php/dav/principals/users/USERNAME/
Enter your user name and password.

Select Next.

© © N 0k w N

If your server does not support SSL, a warning will be displayed. Select
[ Conti nue].

[EY
o

. If the iPhone is unable to verify the account information perform the following:
o Select [ K] .

o Select advanced settings.
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o If your server does not support SSL, make sure Use SSL is set to OFF.
o Change port to 80.

o Go back to account information and click [ Save] .

Now should now find your contacts in the address book of your iPhone. If it’s still not
working, have a look at the Troubleshooting Contacts & Calendar guides.

Synchronizing with KDE SC

>

=== DAY groupmane reLOUrcE

=3

Dummy MailTransport Resource:
Dnamimy Rescinrce implementing mall bransport interlace

-
— -

[ T o
W Ok @ cancel

From KDE SC 4.8 and forward setting up ownCloud is very easy. Note that the KDE
calendar needs to have the ownCloud Calendar and Contacts apps enabled on the
ownCloud server. You need both and not just the Calendar. From System Settings
Personal Information/Akonadi Resources Configuration select DAV Groupware
resource.

m D' gioupwaie conliguistion witaid L -]

Cradestiali
Enter your creden bals bo login bo the proupware se=rser

LE8T  utdr narms

Fepwnrd  SeeEeese

Enter your ownCloud username and password and click [ Next] .
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Select ownCloud in the drop down list and click [ Next] .

Enter the host name and installation path. If you do not use SSL remember to de-
select "Use secure connection".

Test the connection. If everything went well you should see a message like the one
below.
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Genersl conliguration
Display name owniloud
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Lsarname | usernama

Paswword il

Server confgaration

Protocol URL el
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Click "Finish" and you will be able to change the display name and refresh interval.

=== ownCloud
<% Syncing Folder 'Default calendar' (100%)

Now you should see the Akonadi resource doing the first synchronization.

You can find the Contacts and Calendars in Kontact (or KOrganizer/KAddressbook if
you run the programs separately.)

v~ % ownCloud
+| [ Default calendar

Address Books Mame W

v % ownCloud ¥ Arthur Schiwen
+| |55 default Y Bart Visscher
- % Cornelius Schumacher
Y Craig Roberts
I Florian Jacob
‘B Frank Karlitschek
Georg Ehrke
E£2 Jakob Sack
®Y Jlan-Christoph Borchardt
A Klaas Freitag
Y Michael Gapczynski
! Michael Grosser
Robin Appelman
o Tom Meedham

Synchronizing with OS X

To use ownCloud with iCal you will need to use the following URL.:
https://example.com/remote.php/dav/principals/users/USERNAME/

The setup is basically the same as with iOS using the path
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https://example.com/remote.php/dav/principals/users/USERNAME/ to sync with
ownCloud. For OS X 10.7 Lion and 10.8 Mountain Lion everything works fine, but OS
X 10.6 (Snow Leopard) and older needs some fiddling to work. A user contributed the
following:

1. Make sure, addressbook is not running. If it is, select the windows and press
Command+Qto terminate it.

2. Navigate to Users » YOUR_USERNAME > Library > Application Support >

AddressBook > Sources. If you already have some kind of addressbook setup, it is
likely you will see some folders named like this BEA92826-FBF3-4E53-B5C6-
ED7C2B454430. Note down what folders there are now and leave the window
open.

3. Open addressbook and try to add a new CardDav addressbook. At this point, it does
not matter what information you enter. It will come up with the same error message
you mentioned before when you click [ Cr eat €] . Ignore it and click [ Cr eat €] again.
A non-functional addressbook will be added.

4. Close addressbook again using Conmand+Q

5. Go back to the folder window from step 2. You will now see a newly created folder
with another long string as its name.

6. Navigate to the newly created folder and edit the Configuration.plist with your
favorite text editor.

7. Search for a section looking like this:

<key>servername</key> <string>https://:0(null)</string>
<key>username</key> <string>Whatever_you_entered_before</string>

8. Make it look like this. Please note that the :443 after example.com is important:

<key>servername</key
<string>https://example.com:443/owncloud/remote.php/dav/principals/users/US
ERNAME</string> <key>username</key <string>username</string>

9. Save the file and open addressbook again. It will not work yet.

10. Open the preferences for your ownCloud CardDAV-Account and enter your
password.

11. You may have to restart addressbook once more. After this, it should work.

If it’s still not working, have a look at the Troubleshooting Contacts & Calendar
guides.

Thunderbird - Synchronize Addressbook

As someone who is new to ownCloud, New to SoGo Connector, and new to
Thunderbird Addressbook, here is what you need in excruciating pithy detail to make
this work (for all the other lost souls out there):

1. Thunderbird for your OS unless it comes with your OS distribution (Linux)

2. Sogo Connector (latest release)
With an installed Thunderbird mail tool, an installed SoGo Connector add-on:

1. Thunderbird Addressbook is in the Thunderbird "Tools" Menu

78 | Thunderbird - Synchronize Addressbook


admin_manual:configuration/general_topics/general_troubleshooting.pdf#troubleshooting-contacts-calendar
https://www.thunderbird.net/en-US/
https://www.sogo.nu/download.html#/frontends

2. In the Thunderbird Addressbook application:
° File » New > Remote Addressbook (SoGo Connector added this)

o "Name:" is the name you want to give your Addressbook in the Thunderbird
addressbook bar area

o "URL:" is found in your ownCloud Contacts area, click the little [ gear synbol ]

o

in the -bottom left- of the Contacts View (same symbol as found in the -top right- in the
Calendar view). Then look for a little impeller symbol

v

which will display the URL you need for your installation to work.

@ il Remote Address Bock Properties

(x
&
x

MName: craig - mydomain.com

LIRL: [https:ﬂuwncluud.rnydumain.ccmfremute.phpfcarddavfaddresabuuksfcraigfcuntacts ]

| Bead Only

W 0K @ cancel

Once installed, synchronize (right click on your newly made remote address book and
select [ Synchroni ze] ). You’ll see your address book populate from ownCloud! Don’t
click [read onl y] above unless you don’t want to modify your ownCloud server
addressbook, like it contains a listing of corporate contacts and is shared with lots of
people, and you don’t want a new user dragging it somewhere unintended.

The rest of the details of dealing with Thunderbird addressbook are left to the
reader... First thing I learned is dragging a contact to a different addressbook is a
move operation. If you are worried about losing the contact, save it to a VCF file using
ownCloud (Or LDIF using Thunderbird Addressbook) first! Like dragging from the
ownCloud Addressbook to the Personal Address Book removes the contact from
ownCloud Server (deleting it from all the other synchronized installations) and puts it
in your Local Machine -only-Address Book. So be careful or you’ll have unintended
consequences where you might have intended a copy operation.

Contact Pictures are also sync’ed!
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Troubleshooting

Listed here are the most common errors you may encounter while attempting to
upload files, along with what they mean and possible workarounds.

Error while copying file to target location (copied
bytes: xxx, expected filesize: yyy)

This error is most likely due to an issue with the target storage location. During file
uploads the file data is read from PHP input and copied into a part file on the target
storage.

If the target storage is not local (e.g.: FTP) and that storage is slow, not available, or
broken it is likely that the operation will fail either at the beginning, or in the middle of
the copy. Other reasons for this message can be that, when writing to external storage,
the connection took too long to respond or the network connection was flaky.

Sharing sidebar does not show Shared with you by ...
for remote shares

In some scenarios, when users share folders and files with each other they cannot be
scanned. There are a variety of reasons why this happens, which can include firewalls
and broken servers.

In these situations, when the initial scan did not complete successfully, the mount
point cannot appear in the ownCloud web UI. This is because ownCloud was not able
to generate a matching file cache entry, nor retrieve any metadata about whether it’s a
folder or file (mime type), etc.

PIM Troubleshooting

BlackBerry OS up to 10.2.2102 does not accept a URL with protocol https:// in front of
the server address. It will always tell you that it cannot login on your server. So
instead of writing:

https://example.com/remote.php/dav/principals/users/USERNAME/
in the server address field, you have to write:

example.com/remote.php/dav/principals/users/{USERNAME/
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Have You Found a Mistake In The
Documentation?

If you have found a mistake in the documentation, no matter how large or small,
please let us know by creating a new issue in the docs repository.
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